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BAB I 

MEMBUAT DAN MENYIMPAN DOKUMEN KERJA 

 

1.1. Menjalankan Microsoft Word 2007 

Ada banyak cara untuk membuka Microsoft Word diantaranya adalah : 

1. Klik tombol Start > All Program Microfoft Office > Microsoft Office 2007 

 

Gambar 1.1 Menjalankan Microsoft Word melalui All Program 

2. Klik tombol Start > Run > Ketikkan “winword” > Enter 

 

Gambar 1.2 Menjalankan Microsoft Word melalui Menu Run 

3. Klik 2x pada shortcut Microsoft Word yang ada di dekstop 

 

Gambar 1.3 Menjalankan Microsoft Word melalui Dekstop 
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1.2. Pengenalan Interface/Tampilan Word 2007 

Pada windows Microsoft Word 2007 yang muncul, terdapat beberapa 

tampilan sebagai berikut (tunjukkan dengan mouse anda masing–masing 

komponen berikut) : 

1. Office Button  

2. Quick Access Toolbar  

3. Title Bar  

4. Tabmenu Ribbon  

5. Ribbon  

6. Status Bar  

7. Horizontal Scroll Bar  

8. Vertical Scroll Bar  

9. Document Area 

 

 

 

 

 

 

  

Ribon 

Dokumen 

Area 

Title Tab 

Menu 

Quick 

Access 

Office 

Button 

Vertikal 

Scroll Bar 

Status Bar 



 Bahan Ajar Modul  

 Perangkat Lunak Pengolah Kata  

Teknologi Informasi dan Komunikasi (TIK) 

SMP Islam Al Abidin 

Kelas VII Semester I 3 

 

1.3. Mengaktifkan Menu-menu pada Microsoft Word 

Untuk mengaktifkan menu-menu pada Microsoft Word Langkah-

langkahnya adalah sebagai berikut : 

1. Untuk mengaktifkan Menu Home, coba anda klik tab Menu Home pada tab 

menu atau tekan Alt+H, perhatikan ribbon menu yang tampil.  

 

2. Untuk mengaktifkan Menu Insert, coba anda klik Menu Insert pada tab menu 

atau tekan Alt+N, perhatikan ribbon menu yang tampil. 

 

3. Untuk mengaktifkan Menu Page Layout, coba anda klik tab Menu Page Layout 

pada tab menu atau tekan Alt+P, perhatikan ribbon menu yang tampil.  

 

4. Untuk mengaktifkan Menu References, coba anda klik tab Menu References 

pada tab menu atau tekan Alt+S, perhatikan ribbon menu yang tampil.  

 

5. Untuk mengaktifkan Menu Mailing, coba anda klik tab Menu Mailing pada tab 

menu atau tekan Alt+M, perhatikan ribbon menu yang tampil . 
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6. Untuk mengaktifkan Menu Review, coba anda klik tab Menu Review pada tab 

menu atau tekan Alt+R, perhatikan ribbon menu yang tampil.  

 

7. Untuk mengaktifkan Menu View, coba anda klik tab Menu View pada tab 

menu atau tekan Alt+W, perhatikan ribbon menu yang tampil.  

 

8. Untuk mengaktifkan Menu Design, coba anda klik tab Menu Design pada tab 

menu atau tekan Alt+J kemudian tekan T, perhatikan ribbon menu yang tampil.  

 

9. Untuk mengaktifkan Menu Layout, coba anda klik tab Menu Layout pada tab 

menu atau tekan Alt+J kemudian tekan L, perhatikan ribbon menu yang tampil.  

 

Tips : Jika mouse anda terdapat tombol scrollnya, maka anda dapat berpindah 

dari satu menu ke menu lainnya dengan menggeser tombol scroll yang ada 

pada mouse anda.  

   

 

Tombol Scroll 
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1.4. Membuat Dokumen Baru Dalam Microsoft Word 2007  

Langkah untuk membuat dokumen baru adalah : 

1. Klik Office Buttom >New.  

2. Pada Kotak Dialog yang muncul Pilih >Blank Document >klik tombol 

Create.  

 

3. Untuk membuat dokumen baru dari Templates, pilih pada bagian kelompok 

Templates, Klik Tombol Create. 

 

4. Pada windows yang muncul, letakkan kursor dimana anda akan mulai 

mengetik.  
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Soal Latihan  

Ketikkanlah Teks di bawah ini : 

Alasan Di Balik Kegagalan. 

Bila anda mencari alasan untuk sebuah kegagalan, anda bisa temukan berjuta-juta 

dengan mudahnya. Namun, alasan tetaplah alasan. Ia takkan mengubah kegagalan 

menjadi keberhasilan. Kerapkali, alasan serupa dengan pengingkaran. Semakin banyak 

menumpuk alasan, semakin besar pengingkaran pada diri sendiri. Ini menjauhkan anda 

dari keberhasilan; sekaligus melemahkan kekuatan diri sendiri. Berhentilah mencari 

suatu alasan untuk menutupi kegagalan. Mulailah bertindak untuk meraih 

keberhasilan. 

Belajarlah dari penambang yang tekun mencari emas. Ditimbanya berliter-liter tanah 

keruh dari sungai. Ia saring lumpur dari pasir. Ia sisir pasir dari logam. Tak jemu ia 

lakukan hingga tampaklah butiran emas berkilauan. Begitulah semestinya anda 

memperlakukan kegagalan. Kegagalan itu seperti pasir keruh yang menyembunyikan 

emas. Bila anda terus berusaha, tekun mencari perbaikan di sela-sela kerumitan, serta 

berani menyingkirkan alasan-alasan, maka anda akan menemukan cahaya 

kesempatan. Hanya mencari alasan, sama saja dengan membuang pasir dan semua 

emas yang ada di dalamnya. 

*************************************************************** 

Tahukah Anda. 

Nama Pasifik sebagai sebutan bagi Lautan Teduh sebenarnya adalah keliru. Saat 

pelayaran keliling dunianya, Magellan menyeberangi lautan itu tanpa sekalipun 

menemui badai. Samudera yang luasnya tiga kali benua Asia inipun kemudian diberi 

nama olehnya dengan sebutan "Mar Pacifico" (Lautan Teduh).   

Magellan sebenarnya cuma beruntung. Secara kenyataan, Pasifik adalah samudera 

yang memiliki paling banyak badai dan paling ganas diantara samudera-samudera 

lainnya di muka bumi.  

*************************************************************** 

Kata Bijak Hari Ini.                          

Ancaman nyata sebenarnya bukan pada saat komputer mulai bisa berpikir seperti 

manusia, tetapi ketika manusia mulai berpikir seperti komputer. (Sydney Harris) 
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1.5. Menyimpan Dokumen Kerja   

Simpanlah file anda di drive D: (Data) dengan nama latihan modul1.doc di 

dalam folder atas nama Anda. 

1. Setelah teks selesai anda ketik, klik Office Button.  

2. Pilih Save As (untuk menyimpan dengan nama yang beda dengan nama 

sebelumnya).  

3. Pilih Word Document.  

 

4. Pada windows yang muncul, pilih folder Document, ketikkan nama filenya pada 

File name “latihan bab 1”. Pilih Word Document pada Save as type.  

5. Klik tombol Save.  

 

 

1.6. Membuka Halaman Baru 

1. Click Office Button. Pilih New. Klik Create 

2. Atau Klik Ctrl+N pada keyboard anda 



 Bahan Ajar Modul  

 Perangkat Lunak Pengolah Kata  

Teknologi Informasi dan Komunikasi (TIK) 

SMP Islam Al Abidin 

Kelas VII Semester I 8 

 

BAB II 

MENGEDIT DOKUMEN KERJA DAN MEMFORMAT HURUF 

 

2.1 Membuka Dokumen Kerja Yang Telah Di Simpan  

Cara membuka dokumen kerja yang telah disimpan sebelumnya adalah : 

1. Klik Office Button > Open. 

 

2. Pada kotak dialog yang muncul, pilih folder yang akan dibuka filenya, 

3. Kemudian Pilih nama filenya “Praktek1.doc”.  

4. Klik tombol Open.  

 

2.2 Memindahkan Dan Menduplikasi Teks 

Untuk Praktek memindahkan dan menduplikasi teks, buka file “Praktek 1.doc” 

1. Cara Memindahkan Data 

a. Pilih/seleksi paragraf 1, klik icon cut (Ctrl+X) pada tab ribbon clipboard.  

 

b. Letakkan kursor diakhir dokumen. Kemudian Klik icon Paste (Ctrl + V).  
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2. Cara Menduplikasi Teks 

a. Untuk menduplikasi teks/ mengkopi, pilih paragraf terakhir, klik icon Copy 

(Ctrl +C).  

 

b. Letakkan kursor di bawah baris ke 2.  

c. Kemudian klik icon Paste (Ctrl + V). 
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2.3 Memformat Huruf/Font  

Cara memformat huruf/font adalah sebagai berikut : 

1. Pilih judul dokumen (blok), klik pada bagian tab ribbon font, pilih jenis huruf 

(font) Century ,ukuran huruf (Size) 14, klik icon Style huruf (Ctrl+B, Ctrl+I, 

Ctrl+U).  

 

2. Klik icon menu Change Case, ganti bentuk huruf menjadi UPPERCASE. 

 

3. Untuk membuat efek huruf, klik icon menu font. 

 

4. Pada kotak dialog yang muncul, centang Stikethrought pada bagian Effect, klik 

tombol OK.  
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2.4 Mengatur Perataan Paragraf 

Teks judul masih dalam keadaan terpilih, pada bagian paragraph, klik icon 

rata tengah (Ctrl+E). Coba lakukan untuk paragraf yang lain sesuai dengan 

contoh dokumen kita, rata seimbang (Ctrl +J), rata kiri (Ctrl+L), rata kanan 

(Ctrl+R). Font Size selain judul 12. 

 

Soal Latihan  
Bukalah file “Praktrek 1.doc” dan edit teks nya sesuai dengan ketentuan berikut : 

1. Untuk Paragraf “Kata Bijak Hari ini”  

1) Pindahkan ke paragraf awal (sesuai contoh) 

2) Gunakan Rata Kiri  

3) Font Size 12 

4) Font Calibri 

2. Untuk Judul : ALASAN DI BALIK KEGAGALAN 

1) Font  : Comic Sans MS 

2) Font Size  : 14 

3) Change Case : UPPERCASE 

3. Untuk Paragraf-1 Semua kata kegagalan di beri efek : 

1) Bold  , Underline, dan Italic 

2) Font Size : 12 

3) Font : Times New Roman 

4. Untuk Paragraf-2 : 

1) Gunakan Text EffectsShadaw 

2) Font Size = 11 

3) Font= Arial 

5. Untuk Paragraf “Tahukah Anda?” 

1) Beri efek Strikethrough untuk semua kata Pasifik 

2) Font Size 10 

3) Font Verdana 



 Bahan Ajar Modul  

 Perangkat Lunak Pengolah Kata  

Teknologi Informasi dan Komunikasi (TIK) 

SMP Islam Al Abidin 

Kelas VII Semester I 12 

 

Kata Bijak Hari Ini 

Ancaman nyata sebenarnya bukan pada saat komputer mulai bisa berpikir seperti 

manusia, tetapi ketika manusia mulai berpikir seperti komputer. (Sydney Harris) 

ALASAN DI BALIK KEGAGALAN 

Bila anda mencari alasan untuk sebuah kegagalan, anda bisa temukan berjuta-juta 

dengan mudahnya. Namun, alasan tetaplah alasan. Ia takkan mengubah kegagalan 

menjadi keberhasilan. Kerapkali, alasan serupa dengan pengingkaran. Semakin banyak 

menumpuk alasan, semakin besar pengingkaran pada diri sendiri. Ini menjauhkan anda 

dari keberhasilan; sekaligus melemahkan kekuatan diri sendiri. Berhentilah mencari 

suatu alasan untuk menutupi kegagalan. Mulailah bertindak untuk meraih keberhasilan. 

Belajarlah dari penambang yang tekun mencari emas. Ditimbanya berliter-liter tanah 

keruh dari sungai. Ia saring lumpur dari pasir. Ia sisir pasir dari logam. Tak jemu ia lakukan 

hingga tampaklah butiran emas berkilauan. Begitulah semestinya anda memperlakukan 

kegagalan. Kegagalan itu seperti pasir keruh yang menyembunyikan emas. Bila anda terus 

berusaha, tekun mencari perbaikan di sela-sela kerumitan, serta berani menyingkirkan alasan-

alasan, maka anda akan menemukan cahaya kesempatan. Hanya mencari alasan, sama saja 

dengan membuang pasir dan semua emas yang ada di dalamnya. 

*************************************************************** 

Tahukah Anda? 

Nama Pasifik sebagai sebutan bagi Lautan Teduh sebenarnya adalah keliru. Saat 

pelayaran keliling dunianya, Magellan menyeberangi lautan itu tanpa sekalipun 

menemui badai. Samudera yang luasnya tiga kali benua Asia inipun kemudian 

diberi nama olehnya dengan sebutan "Mar Pacifico" (Lautan Teduh).   

Magellan sebenarnya cuma beruntung. Secara kenyataan, Pasifik adalah samudera 

yang memiliki paling banyak badai dan paling ganas diantara samudera-samudera 

lainnya di muka bumi.  

*************************************************************** 

 

 

 

 

 

**Simpanlah dengan nama“latihan bab 2”.   
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BAB III 

MEMFORMAT PARAGRAF, BULLET DAN NUMBERING, 

DROP CAP DAN SPASI BARIS 

 

3.1 Membuat Numbering  

Format Numbering berfunsi untuk pe-nomer-an pada suatu paragraph. 

Untuk membuat Numbering langkahnya adalah sebagai berikut : 

1. Ketikkan Teks di bawah ini 

10 Sifat Kerja Orang Jepang :  

Kerja Keras 

Malu 

Hidup Hemat 

Loyalitas 

Inovasi 

Pantang Menyerah 

Budaya Baca 

Kerjasama Kelompok 

Mandiri 

Jaga Tradisi 

2. Blok kata Kerja Keras sampai Jaga Tradisi kemudian Klik icon pada ribbon 

paragraph, kemudian pilih jenis Number Aligment left.  

 

3. Maka hasilnya akan menjadi : 

10 Sifat Kerja Orang Jepang : 

1) Kerja Keras 

2) Malu 

3) Hidup Hemat 

4) Loyalitas 

5) Inovasi 

6) Pantang Menyerah 

7) Budaya Baca 

8) Kerjasama Kelompok 

9) Mandiri 

10) Jaga Tradisi 
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3.2 Membuat Bullet  

Sama seperti Numbering, Bullet berfungsi pula untuk pe-nomer-an pada 

suatu paragraf.Namun bedanya Bullet menggunakan symbol, picture, dan font. 

Untuk mem-format Bullet langkahnya hampir sama dengan Numbering. 

 

Untuk membuat Bulletketikkan tulisan berikut : 

10 Sifat Kerja Orang Jepang : 

 Kerja Keras 

 Malu 

 Hidup Hemat 

 Loyalitas 

 Inovasi 

 Pantang Menyerah 

 Budaya Baca 

 Kerjasama Kelompok 

 Mandiri 

 Jaga Tradisi 

 

3.3 Membuat Drop Cap  

Untuk latihan membuat Drop Cap,Buatlah Dokumen baru (Ctrl + N). 

1. Letakkan kursor di awal dokumen. 

2. Ketiklah teks pada halaman selanjutnya sampai selesai.  

3. Letakkan kursor di awal baris pertama paragraf 1.  

4. Klik tab menu Insert kemudian pilih icon menu Drop Cap >Drop Cap 

Options.  

5. Pada kotak dialog drop cap, pilih icon Dropped, Font : Arial Unicode MS , 

Line to drop : 3, Distance from text : 0.1 cm. Kemudian klik tombol OK.  

6. Kemudian perhatikan hasilnya.  

7. Lakukan hal yang sama untuk paragraph ke-2. 
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ila anda mencari alasan untuk sebuah kegagalan, anda bisa temukan 

berjuta-juta dengan mudahnya. Namun, alasan tetaplah alasan. Ia 

takkan mengubah kegagalan menjadi keberhasilan. Kerapkali, alasan 

serupa dengan pengingkaran. Semakin banyak menumpuk alasan, semakin besar 

pengingkaran pada diri sendiri. Ini menjauhkan anda dari keberhasilan; sekaligus 

melemahkan kekuatan diri sendiri. Berhentilah mencari suatu alasan untuk 

menutupi kegagalan. Mulailah bertindak untuk meraih keberhasilan. 

 dari penambang yang tekun 

mencari emas. Ditimbanya 

berliter-liter tanah keruh dari 

sungai. Ia saring lumpur dari pasir. Ia sisir pasir dari logam. Tak jemu ia lakukan 

hingga tampaklah butiran emas berkilauan. Begitulah semestinya anda 

memperlakukan kegagalan. Kegagalan itu seperti pasir keruh yang 

menyembunyikan emas. Bila anda terus berusaha, tekun mencari perbaikan di 

sela-sela kerumitan, serta berani menyingkirkan alasan-alasan, maka anda akan 

menemukan cahaya kesempatan. Hanya mencari alasan, sama saja dengan 

membuang pasir dan semua emas yang ada di dalamnya. 

 

3.4 Mengatur Jarak Baris/Spasi Baris  

Masih menggunakan teks pada saat latihan untuk membuat Drop Cap, untuk 

mengatur jarak baris/spasi baris lakukan langkah berikut : 

1. Pilih/seleksi semua teks (Ctrl+A), klik tab Home menu. Klik tombol Paragraph 

dialog box pada ribbon. 

2. Pada kotak dialog yang muncul, Klik tab indents and spacing , kemudian 

tentukan lebar spasi 1,5 lines pada line spacing. Klik tombol OK. Perhatikan 

hasilnya. 

 

 

 

 

 

  

B 

Belajarlah 
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 BAB IV  

PENGATURAN MARGIN, MENYISIPKAN TANGGAL, 

MEMBUAT BINGKAI DOKUMEN DAN PANGATURAN 

TABULASI 

 

4.1 Mengatur Margin dan Paper pada Dokumen 

Langkah Detailnya : 

1. Klik tab Menu Page Setup.  

2. Pilih tombol Page Setup Dialog Box.  

 

 

4.2 Menambahkan tanggal dalam dokumen   

Menambahkan tanggal dalam dokumen dapat dilakukan dengan cara :Klik 

tab menu Insert > Date&Time. Tanggal dalam file dokumen otomatis akan 

berubah sesuai dengan tanggal membuka file dokumen kembali. 
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4.3 Membuat Bingkai Halaman, Paragraf  Dan Teks 

1. Membuat Bingkai Halaman 

Langkahnya : 

a. Untuk Membuat Bingkai halaman, letakkan kursor pada halaman 1.  

b. Pilih tab menu Page Layout.  

c. Klik Page Border.  

d. Pada kotak dialog yang muncul, klik tab Page Border.  

e. Pada bagian Setting, pilih Box, pada bagian Style, pada bagian Art pilih Jenis 

bingkai sesuai contoh dokumen, Width : 30.  

f. Pada Apply to, pilih Whole document untuk menerapkan bingkai pada 

seluruh halaman, first page only untuk halaman pertama saja. Klik tombol 

Option.  

g. Pada kotak dialog yang muncul, pilih text pada Measure from agar bingkai 

rapat ke teks. Klik tombol OK.  

 

2. Membuat Bingkai Paragraf dan Shading pada Teks 

Ini adalah contoh bingkai paragraf dan teks   

Langkahnya : 

a. Pilih teks baris kedua.  

b. Klik tab menu Home, klik icon menu Border and Shading pada ribbon 

Paragraph  

c. Klik tab Border, pada bagian Setting pilih Box, Style : Pilih garis sesuai 

contoh, Color: Automatic, Width: 3.  

d. Pada Aplly to pilih text. Klik OK.  

e. Setelah itu baru atur shading nya. 
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4.4 Menggunakan Menu Tab  

Menu Tab biasanya digunakan untuk membuat daftar isi. Untuk membuat Menu 

Tab langkanya adalah sebagai berikut : 

1. Ketikan teks berikut : 

Materi Microsoft Word 2007 

Modul 1. Membuat Dan Menyimpan Dokumen Kerja   

Menjalankan Microsoft Word 2007   

Pengenalan Interface/Tampilan Word 2007   

Mengaktifkan Menu–Menu Pada Microsoft Word 2007  

Membuat Dokumen Baru Dalam Microsoft Word 2007   

Menyimpan Dokumen Kerja    

Menutup Dokumen Kerja 5 

Tugas Modul 1   

 

Modul 2. Mengedit Dokumen Kerja Dan Memformat Huruf  

Membuka Dokumen Kerja Yang Telah Di Simpan   

Memilih Teks Yang Akan Di Format/Edit   

Memindahkan Dan Menduplikasi Teks   

Memformat Huruf/Font   

Mengatur Perataan Paragraf   

Tugas Modul 2   

 

Modul 3. Memformat Paragraf, Bullet Dan Numbering, Drop Cap Dan 

Spasi Baris  

Membuat Numbering   

Membuat Bullet   

Membuat Drop Cap   

Mengatur Jarak Baris/Spasi Baris   

Tugas Modul 3   

 

2. Pilih semua teks kecuali judulnya.  

3. Klik tab menu Home, klik icon menu Paragraph, pada kotak dialog yang 

mucul klik tombol Tabs.  

4. Pada kotak dialog tabs, isikan tab stop posisition :14.5 cm, Aligment : Left, 

Leader : None, kemudian klik tombol Set.  
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5. Maka hasilnya akan menjadi seperti berikut : 

  

Materi Microsoft Word 2007 

Modul 1. Membuat Dan Menyimpan Dokumen Kerja .............................. 1 

Menjalankan Microsoft Word 2007  ................................................................ 2 

Pengenalan Interface/Tampilan Word 2007  .................................................... 2 

Mengaktifkan Menu–Menu Pada Microsoft Word 2007  ................................ 3 

Membuat Dokumen Baru Dalam Microsoft Word 2007 ................................. 4 

Menyimpan Dokumen Kerja   .......................................................................... 4 

Menutup Dokumen Kerja  ................................................................................ 5 

Tugas Modul 1 ................................................................................................. 6 

 

Modul 2. Mengedit Dokumen Kerja Dan Memformat Huruf  .................. 7 

Membuka Dokumen Kerja Yang Telah Di Simpan  ........................................ 7 

Memilih Teks Yang Akan Di Format/Edit  ...................................................... 8 

Memindahkan Dan Menduplikasi Teks  .......................................................... 9 

Memformat Huruf/Font  ................................................................................... 9 

Mengatur Perataan Paragraf  ............................................................................ 10 

Tugas Modul 2 ................................................................................................. 11 

 

Modul 3. Memformat Paragraf, Bullet Dan Numbering, Drop Cap Dan 

Spasi Baris  ...................................................................................................... 12 

Membuat Numbering  ...................................................................................... 13 

Membuat Bullet  ............................................................................................... 14 

Membuat Drop Cap  ......................................................................................... 14 

Mengatur Jarak Baris/Spasi Baris  ................................................................... 15 

Tugas Modul 3 ................................................................................................. 15 
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4.5 Menghapus Tabulasi Dalam Dokumen 

Untuk menghapus Tabulasi dalam dokumen, lakukan langkah berikut : 

1. Pilih kembali semua teks daftar isi, kecuali judulnya.  

2. Buka kembali kotak dialog tab (lihat pada materi sebelumnya).  

3. Pada kotak dialog tab, klik tombol Clear All.  

4. Klik OK 

 

 

 

Soal Latihan 

Untuk lebih memahami materi pada modul yang telah kita pelajari, buatlah dokumen/ 

sertifikat dengan tampilan seperti berikut (gunakan bingkai sesuai yang anda inginkan). 

Setelah selesai simpanlah dengan nama“latihan bab 4”.  
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BAB V 

MENYISIPKAN TEXT BOX, WORD ART, DAN CLIP ART 

 

5.1 Menyisipkan Text Box ke Dalam Dokumen 

1. Letakkan kursor pada akhir paragraf ke-2 dokumen “Alasan di Balik Kegagalan”.  

2. Klik tab menu Insert, klik icon menu Text Box pada daerah ribbon kelompok Text.  

3. Pilih Draw Text Box untuk membuat text box yang baru.  

4. Klik tahan tarik, dan gambarkan (lihat contoh soal).  

5. Ketikkanlah isi text box sesuai contoh soal. Setelah selesai di ketik, pilih semua teks 

yang ada di text box, tekan tombol Ctrl+E.  

6. Untuk memformat text box, klik pada tepi text box, klik tab menu Format, kemudian 

pilih Text Box Style dan pilih jenis style (lihat style text box soal).  

7. Klik icon menu Shadow Efect. Pilih salah satu jenis shadow yang ada, kemudian lihat 

perbedaannya.  

8. Sekarang klik icon menu 3-D Effect, kemudian pilih 3-D Style1.  

9. Untuk mengatur perataan text box terhadap teks dokumen, klik icon menu Text 

Wrapping, kemudian pilih Tight. Coba anda pilih jenis yang lain, dan lihat 

perubahannya pada dokumen kita.  

 

5.2 Menyisipkan Word Art 

1. Buka kembali file ”Gabung File”.  

2. Letakkan kursor di awal dokumen.  

3. Klik tab menu Insert, kemudian pilih icon Word Art pada ribbon kelompok text. Pilih 

Word Art Style 21. 

4. Ketikkan Isi Wort Art “Menggabungkan Beberapa Dokumen”, dan jenis (font) huruf 

:Arial Black, ukuran (size) : 36.  

5. Klik OK 
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6. Klik icon menu Spacing pada ribbon Text , kemudian klik Close.  

 

7. Klik pada tab ribbon Word Art Style, ganti style menjadi WordArt Style 16. (coba 

anda klik style yang lain, lihat perbedaanya).  

 

5.3 Menyisipkan Clip Art 

Untuk menyisipkan Clip Art langkahnya adalah : 

1. Masih menggunakan “Gabung file”. Kemudian letakkan kursor pada akhir halaman 

pertama.  

2. Kemudian, klik tab menu Insert > Clip Art.  

3. Kemudian klik tombol Go pada kotak dialog clip art. Perhatikan clip art yang 

muncul.  

4. Kemudian klik gambar clip art “menara”. Perhatikan gambar sudah ditambahkan ke 

dalam dokumen.  
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5. Klik icon menu Brightness (-20%), perhatikan perubahannya. Coba anda lakukan 

untuk icon menu adjusment picture yang lainnya  

 

6. Untuk format yang lainnya, lihat pada materi Text box. Setelah selesai simpan 

kembali dokumen anda.  

 

 

Soal Latihan 

Untuk lebih memahami materi pada modul yang telah kita pelajari, Buat dokumen seperti di 

bawah ini. (logo, gambar boleh tidak sama).  Setelah selesai simpanlah dengan nama“latihan 

bab 5”.  
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BAB VI 

MEMBUAT HYPERLINK, WATERMARK  

DAN MENCETAK DOKUMEN 

 

6.1 Membuat dan Memanfaatkan Hyperlink 

1. Buka kembali file Daftar Isi : 

2. Pilih teks “Daftar Isi”.  

3. Pilih tab menu Insert, kemudian pilih icon menu Hyperlik pada kelompok ribbon  

 

4. Pada kotak dialog yang muncul, pilih file yang akan di tuju, missal pilih BAB I. 

5. Klik tombol OK.  

6. Untuk menggunakan linknya, tekan Ctrl+klik pada teks Daftar Isi. Maka link akan 

membuka file linknya (BAB1.doc).  
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6.2 Menggunakan Watermark 

1. Buka kembali file “Tugas Modul 1”.  

2. Klik tab menu Page Layout > Watermark > Custom Watermark.  

 

3. Aktifkan pilihan Text watermark, isikan “Alasan Dibalik Kegagalan” pada bagian 

Text. Pilih jenis huruf Arial Black, kemudian klik tombol OK.  

 

 

6.3 Mencetak Dokumen 

 

1. Buka kembali file Alasan dibalik kegagalan.  

2. Klik Office button.  

3. Pilih Print (Ctrl +P).  

4. Klik All pada Page (jika ingin mencetak semua halaman).  

5. Number of copies : 1.  

6. Print what : Dokument, Print : All pages in range.  

7. Pada bagian Zoom, Pages per sheet : 1 page.  

8. Scale to Paper size ; A4.  

9. Kemudian klik tombol OK.  
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BAB VII 

MEMBUAT DIAGRAM DAN GRAFIK 

 

7.1 Menyisipkan Diagram Dalam Dokumen 

Untuk menyisipkan Diagram dalam Dokumen, terlebih dahulu buatlah gambar 

diagram seperti di bawah ini : 

 
Langkahnya adalah : 

1. Buatlah dokumen baru (Ctrl + N).  

2. Klik tab menu Insert kemudian pilih Smart art.  

3. Pada kotak dialog yang mucul, pilih Hierarchy, kemudian klik OK.  

4. Kemudian klik pada shape level ke tiga, tekan tombol Delete pada keyboard.  

5. Perhatikan perubahannya. Kemudian klik shape level ke tiga kanan bawah (lihat 

gambar).  

6. Klik tab menu Design, kemudian klik icon menu Add Shape, pilih Add Shape 

Before.  

7. Lakukan langkah yang sama untuk menambahkan shape yang sama (lihat contoh 

latihan).  

8. Kemudian klik di dalam shape, dan mulailah ketikkan isi teksnya.  

9. Simpan dokumen anda dengan nama “bagan organisasi”.  
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7.2 Membuat Diagram Grafik 

Buatlah grafik di bawan ini : 

 
1. Buatlah Dokumen Baru (Ctrl + N)  

2. Klik tab menu Insert, kemudian klik icon menu Chart pada ribbon Illustrations.  

3. Pada kotak dialog Insert Chart, pilih Column > Clustered Cylinder, kemudian klik 

tombol OK.  

 

4. Pada kotak dialog yang mucul, pada bagian Windows Excel, ketikkanlah data di 

bawah ini : 

 

Tahun 2011 Januari Februari Maret April May 

Blackberry 400 550 670 800 800 

Nokia 800 750 755 800 900 

Samsung 350 350 350 350 350 

Sony Ericson 250 250 250 250 250 

Merk Cina 300 500 600 700 800 
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5. Setelah selesai klik Close untuk Windows Excelnya, kemudian perhatikan grafiknya.  

6. Untuk membuat judul grafiknya, aktifkan grafik yang telah kita buat, kemudian klik 

tab menu Layout > Chart Title > Above Chart. 

7. Kemudian pada kotak dialog yang muncul, ketikkan judul grafiknya “Penjualan 

Handphone d’Cell Periode Januari – Mei 20011” . 

8. Klik pada icon menu Axis Title, pilih Primary Horizontal Axis Title, kemudian pilih 

Title Below Axis.  

9. Pada kotak dialog yang muncul, ketikkan judul axisnya “Merek Handphone”.  

10. Kemudian klik icon menu Axis Title > Primary Vertical Axis Title > Rotated Title.  

11. Ketikkan judul Axisnya “Unit Penjualan”.  

12. Kemudian klik icon menu Data Labels > Show, perhatikan perubahannya.  

13. Setelah selesai simpan dengan nama “Grafik Penjualan 2011”.  
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BAB VIII 

MEMBUAT DAN MENCETAK MAIL MERGE 

 

8.1 Membuat Mail Merge 

1. Sebelum membuat Mail Merge, kita harus membuat dokumen Induk/dokumen 

utama. Buatlah dokumen induk di bawah ini :  

 

2. Setelah dokumen induk selesai simpan dengan nama “Formulir”. Kemudian klik tab 

menu Mailings.  

3. Pada bagian ribbon kelompok Start Mail Merge klik icon menu Start Mail Merge.  

4. Kemudian pilih Step by Step Mail Merge Wizard.  

5. Pada kotak dialog yang muncul, pilih Letters pada bagian Select document type. 

Kemudian klik Next : Starting document.  
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6. Pada step yang selanjutnya, pilih Use the current document, klik Next.  

 

7. Pada Step yang ketiga ini kita akan membuat sumber data (data source) untuk mail 

merge. Sumber data kita adalah sebagai berikut :  

Office_Address_List 

NAMA KELAS ALAMAT NO TELPON KEGIATAN 
BIAYA 

ADMIN 

Sandy Aulia Aisyah Jl. Kaliurang 4 Jogja 085712345678 Karikatur Rp. 2000 

Nia Rahmania Fatimah Az-
Zahra 

Jl. Pandanaran - 
Boyolali 

087123456789 Kriya Rp. 2000 

Aji Prasetyo Lukman Jl. Jambu No.5 Solo 089748392941 Band Rp. 2000 

Raditya 
Prabowo 

Harun Jl. Kelinci N0.16 085636472839 Komputer Rp. 2000 

 

Pilih Type a new list kemudian klik teks Create. Kemudian klik Next : Write your letter.  

 

8. Pada kotak dialog yang muncul, judul dari kolom tidak sesuai dengan dokumen 

induk kita. Klik tombol Custemize Column lalu pada Custemize Address List pilih 

Add kemudian masukkan Customize Address List. Kemudian data yang tidak 

dibutuhkan dapat dihapus dengan menggunakan tombol Delete. Atau dapat pula kita 

mengedit Customize Address List dengan cara pilih Field Name yang akan diganti, 

kemudian klik tombol Rename. 
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9. Ketikkan Nama pada Change field name. Setelah selesai klik tombol OK. Lakukan 

hal yang sama untuk field yang lain.  

10. Kemudian klik tombol OK, dan mulailah mengisikan datanya. Untuk menambah data 

yang baru klik tombol New Entry.  

11. Setelah semua data diinput, klik tombol OK.  

12. Kemudian tentukan tempat penyimpanan, dan ketikkan nama data sourcenya adalah 

mail formulir. Kemudian klik tombol Save.  

 

13. Kemudian klik Next : Write your letter. Pada kotak dialog yang muncul, letakkan 

kursor di sebelah field nama, kemudian klik More Item, Pilih field Nama, kemudian 

klik Insert. Lakukan untuk memasukkan field yang lainnya.  
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14. Klik tombol Next : Write your letter.  

 

15. Pada step yang ke 5 ini anda dapat melihat masing–masing isi datanya dengan 

mengklik Preview your letter. Kemudian klik Write your letter.  

 

8.2 Mencetak Mail Merge 

1. Pada step yang ke 6 ini, klik icon Print untuk mencetak mail merge yang kita buat 

atau Edit individual letters untuk melihat hasil mail merge secara mendetail. Klik 

icon Print  

2. Pada kotak dialog yang muncul, pilih Alluntuk mencetak semua data mail merge kita. 

Klik OK.  

3. Kemudian atur setingan printer pada kotak dialog Print.( Lihat materi mencetak 

dokumen). Klik tombol OK.  

 

 

Soal Latihan 

Untuk lebih memahami materi pada modul yang telah kita pelajari, Buatlah Surat Undangan 

Kegiatan OSIS yang ditujukan untuk semua Guru SMP Islam Al Abidin. Gunakan Mail 

Merge !! 

 


